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Micro Focus Academic Program 4.0 Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Overview
The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.
COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.
The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.
This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.
Welcome! We’re excited to have you join our growing academic community.
Product Description
The Micro Focus Academic Program Edition package comprises the following products:
•

Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.
Variants of Visual COBOL include:

•

• Visual COBOL for Visual Studio 2013, Visual Studio 2015 or Visual Studio 2017
• Visual COBOL for Eclipse (Windows)
Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:
•
•

Enterprise Developer for Visual Studio 2013, Visual Studio 2015 or Visual Studio 2017
Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:
•
•
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You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.
An authorization code for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.
For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.
Reporting Issues
•

For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site for any
updates to the documentation which might have been uploaded.

Upgrading from earlier Micro Focus products
Version 4.0 of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with an earlier version of your
product might not be compatible with version 4.0 run-time products. If the behavior of your application
changes with version 4.0, we strongly recommend that you relink the main executable with version 4.0.
This will ensure that the COBOL run-time system fully handles any run-time error conditions that might
occur.
A new executable that is fully compatible with version 4.0 can be produced without recompiling the
application, as long as the original object code is available and it is relinked with version 4.0.
To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.
If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar (Visual Studio 2015 and 2017) or a dialog box (Visual Studio
2013) providing an option for you to choose and relink the project.
If you are using Eclipse, Visual COBOL 4.0 can automatically relink existing projects created with Visual
COBOL 3.0 that have executable link artefacts. Eclipse displays a warning in the Problems view that the
project requires relinking. It then offers a Quick Fix action for you to execute that will link your project with
the most recent version of the Run-Time System.

What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•

Integration with Visual Studio
Integration with Eclipse
Application Server JCA Support for Enterprise Server
Application Workflow Manager
AppMaster Builder
Build Tools for Windows
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Code Coverage
Codeset support
Compiler directives
Data File Tools
Database Connectors
Debugging
Docker
Documentation on working with large applications
Enterprise Server
Enterprise Server for .NET
File Handler
HCO for DB2 LUW
IMS support
JCL support
Mainframe Access
Managed COBOL
Library routines
Micro Focus Unit Test Framework
OpenESQL
Platform support
PL/I support
Web Service Clients

Integration with Visual Studio
Back to Top
This release includes the following editor improvements:
•
•

•
•

Inline rename refactoring - overwriting a variable name directly in the editor now invokes rename
refactoring so you no longer need to select Refactor from the editor context menu.
Extract to section - a new quick action (Visual Studio 2015 and later only) is available in the editor. It
enables you to refactor your code by adding more sections in the code. This can help you create more
entry points that you can use during unit testing.
Automatic insertion of END-EXEC, END-TRY and END-PERFORM statements - the closing statements
are now automatically inserted after you have typed the opening statements.
IntelliSense filters (Visual Studio 2017 and later only) - when IntelliSense displays a list of suggestions,
a number of icons at the bottom of the IntelliSense window now enable you to filter the suggestions.

Working with files:
•
•
•

Copybook graphs - a context menu command, Show Copybook Graph, in Solution Explorer enables
you to display the graphical representation of the copybook dependencies of COBOL programs.
Open Folder mode (Visual Studio 2017 only) - support is now available for editing, compiling and
debugging files opened in Solution Explorer in Open Folder mode without having to create projects.
The file property pages now display a list of all Compiler directives that apply to the file.

New IDE configuration option:
•

You can use the Limit IntelliSense Search Scope setting in Tools > Options > Text Editor > Micro
Focus COBOL > Advanced that helps improve the editor performance.

Relinking existing applications in Visual Studio:
•

6

You can now configure Visual COBOL to check whether applications created with older releases must
be relinked. If the application uses an older version of the C runtime, Visual COBOL can automatically
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relink the existing executable or .dll to the new version of the C runtime without the need to recompile
the application first.
If a project needs relinking, Visual Studio displays a message in the status bar (Visual Studio 2015 and
2017) or a dialog box (Visual Studio 2013) providing an option for you to choose and relink the project.
Integration with Eclipse
Back to Top
This release provides the following general enhancements:
•

Support for Eclipse 4.7 Oxygen (64-bit) and 64-bit project templates - the 64-bit Eclipse 4.7 is now
installed by default. Project templates are available for both 32-bit and 64-bit applications. You can set a
default project template (either 32-bit or 64-bit) to use so that all future new projects will use that as the
preference. On platforms only capable of building to 64-bit, the 64-bit templates are the default ones.
The 32-bit Eclipse is still supported on 64-bit Windows platforms, however you need to manually install
it and a 32-bit Java.

•
•

•
•

•

Support for Eclipse 4.4 and 4.5 has been discontinued.
Support for SUSE 12 - only the 64-bit SUSE 12 platform is supported and you can only use the 64-bit
Eclipse with 64-bit projects on it.
(Native COBOL projects only) The Project Settings page in the project's properties now include a
search option. This enables you to find files and build configurations that have settings different from the
ones set at project level.
Remove File Directives - a context menu command in the explorer view enables you to reset a file's
directives.
IVP diagnostic tool enhancements - it is now possible to run the server-side IVP diagnostic tool for
diagnosing issues with a remote connection from within Eclipse installed at the client side. The IVP tool
now also performs a check for whether XTERM is installed on the remote machine.
IMTK service mappings are now automatically regenerated if you make a change to the interface fields
in the underlying program.

The following enhancements are available for JVM COBOL projects and package handling:
•
•
•

•
•
•
•
•

New wizards for creating ENUM, DELEGATE and VALUETYPE types.
Additional code snippets for Method-Id and Property-Id.
Showing and grouping packages in the COBOL Explorer view - use the COBOL JVM Project
Presentation command from the View menu in the explorer to either display COBOL categories or
packages.
Refactoring by renaming the package name - available from the context menus in the COBOL Editor
and in COBOL Explorer.
Refactoring by moving source folders, packages or compilation units - available from the explorer
context menu.
Support for switching off the package name mapping using the Each part of the package name
corresponds to a subdirectory option in the Build Configuration page.
Support for packaging .class files in a .jar file when building COBOL JVM projects.
Open Type Hierarchy and Open Call Hierarchy context menu commands - available in the COBOL
editor, COBOL Explorer and in the outline views while seeing the packages presentation in the IDE.

The following editor improvements are available:
•
•
•

A Properties context menu command - enables you to access a file's properties directly from the editor.
A Show In context menu command - enables you to locate the file in the COBOL or the PL/I Explorer.
Edit > Convert Tabs to Spaces command - enables you to convert any tabs in your COBOL source
files to a specified number of spaces.

Automatic relinking of applications created with Visual COBOL 3.0:
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•

Visual COBOL 4.0 can automatically relink existing projects created with Visual COBOL 3.0 that have
executable link artefacts. Eclipse displays a warning in the Problems view that the project requires
relinking. It then offers a Quick Fix action for you to execute that will link your project with the most
recent version of the run-time system.

Application Server JCA Support for Enterprise Server
Back to Top
This release includes the following enhancements:
•
•
•

COBOL Resource Adapters now support WebSphere 9.0 and WebLogic 12.2.1.
Tomcat 7.0 support for servlet generation with J2SEBeans.
NullSearch utility - for COBOL resource adapters, this new utility provides assistance in locating NULL
fields in mappings passed to Enterprise Server. When a large number of arguments is provided in the
parameters passed to Enterprise Server, it is difficult to locate NULL fields, which are not allowed. The
NullSearch utility isolates NULL fields, so the Java application can be corrected.

Application Workflow Manager
Back to Top
Improvements have been made in the following areas:
•

Model editor - now includes:
•

•

A new Edit action. Enables you to edit any model component instead of working with the Properties
view. The new action enables you to change the attribute values of several model components at a
time.
• An Outline and a Relationship Hierarchy view.
• Improved backwards and forwards navigation in the model.
• Automated sequence numbering in the model.
• The context menu of the model editor has been restructured for more clarity.
• Context help.
• Tool creation has been improved. Dependent components are generated from the function package
tool definition.
Development of models:
•

•

Newly created empty models now contain all categories. The new models also validate without any
errors or warnings.
• A new AWM system type, “Custom System”, is available. This system type supports the model
development process by facilitating the creation, change, load and reload of a model.
New modelling features:
•
•
•
•

•
•

The “Return Property Value” tool in the function package now supports several additional use cases.
The “Transfer File” tool in the function package offers improved support for mass processing.
Support for properties with an application-wide scope.
A modelling capability to structure the local file cache for copybooks and include files downloaded by
the background parser in the editor. Additional tools are provided to check the existence of or clear
the file cache for copybooks and include files.

The product help includes some tutorials showing how to create new models and extend the
functionality of existing models. See the Tutorials Guide.
A number of template models are now available and can be used as a base to develop your own
models.

AppMaster Builder
Back to Top

8

| Micro Focus Academic Program 4.0 - Release Notes

This release includes the following new features:
•

•
•

AppMaster Builder is now available in the Team Developer Perspective (Technology Preview) - this
perspective provides a development environment for your AMB projects that includes much of the
functionality available from the AppMaster Builder perspective plus access to the AMB Endevor
Interface (Technology Preview).
AMB Endevor Interface (Technology Preview) - enables you to share and synchronize resources
between an AMB project and mainframe Endevor datasets.
A re-number/un-number feature in the Data Structure Editor.

Build Tools for Windows
Back to Top
This release includes Visual COBOL Build Tools for Windows, a separately-installable component of Visual
COBOL that has been designed to be used in environments where you want to work with your COBOL and
PL/I projects but you don't want the overheads associated with either the Visual Studio or the Eclipse IDE.
Build Tools provide a lightweight, easy-to-install development environment that is well-suited for use in
Docker containers and continuous integration or continuous delivery systems.
Code coverage
Back to Top
This release provides the following enhancements:
•

Support has been added in Eclipse for code coverage for procedural copybooks.

•

In Visual Studio, the Micro Focus Code Coverage window now offers a File View in addition to the
existing Program View.

Codeset support
Back to Top
Support has been added to enable codeset mapping to additionally be configured to use IBM's Conversion
Tables directly instead of the Micro Focus supplied tables. You need to download IBM's conversion tables
from IBM's Web site. Then you can use the MFCODESET environment variable to convert between IBM's
CCSIDs.
Compiler directives
Back to Top
The following Compiler directives are new in this release:
•
•
•
•
•

DISPSIGN - determines the display output of numeric fields with included signs, under an IBM
mainframe dialect only.
GNTLITLINKSTD - stops the suppression of call-convention 8 when both call-convention 2 and callconvention 8 are in effect for a .gnt file in an Intel x86 32-bit environment.
ILSMARTANNOTATE - adds attributes to the items generated by ILSMARTLINKAGE, based on their
data type, which can be used to identify the size or range of the item in COBOL.
ILSMARTTRIM - trims any trailing spaces from a string item returned by the get property associated
with an alphanumeric item processed by ILSMARTLINKAGE.
MAINFRAME-FLOATING-POINT - specifies the format of a program's floating point data items: either
IBM hexadecimal format or IEEE format. This directive is supported in managed code only.

The following Compiler directives contain new parameters in this release:
•

CHECKDIV - a new parameter 'ACOS' now emulates a divide by zero operation on an ACOS
mainframe system: the quotient and the remainder are set to the value of the dividend.

Micro Focus Academic Program 4.0 - Release Notes
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•
•

OOCTRL - a new parameter, L, specifies whether to include directory location comments in .cls
and .ins inheritance files.
NUMPROC - a new parameter 'ACOS' provides partial compatibility with the behavior of NEC ACOS
COBOL processing of invalid data in USAGE DISPLAY data items and invalid sign information in
USAGE COMP-3 data items.

Data File Tools
Back to Top
It is now possible to export any filtered results. When filtering a data file, you can use the results to create a
new data file - click Search > Export Results when a filter is applied to save the filtered records to a new
file. You can:
•
•
•
•

Save the filtered records to a new file.
Save the records that match the specified filter (such as customer information or orders).
Download a subset of the data from a remote file.
Save a small portion of the data for testing purposes.

Database Connectors
Back to Top
Debugging
Back to Top
This release includes the following enhancements:
•

Enhanced .NET debugging in Visual Studio 2017 - a number of advanced debug features are now
available when debugging .NET COBOL code. Features include support for performance tips,
backwards debugging, an expression evaluator, integration with the Diagnostic Tools window, remote
debugging of .NET COBOL applications, as well as support for IntelliSense in the debug windows (such
as the Immediate, Watch, and QuickWatch windows).

•

Debugging CICS channels and containers - you can now debug CICS COBOL applications that use
channels and containers. The debugger now enables you to view the contents of any channels and
containers, and to change content as you debug.

The following enhancements have been made to reverse debugging and live recording in Eclipse:
•

•
•

Reverse debugging and live recording have been enhanced significantly, and are now considered GA
features. You can now debug using watchpoints and conditional breakpoints, and reset execution points.
Debugging multi-threaded applications is now supported, and so are programs that contain OSVS
performs and nested programs.
A command line utility, cobeslr, has been introduced to enable you to configure live recording for
particular services or application instances of an enterprise server region.
You can now use the CBL_DEBUG_START and CBL_DEBUG_STOP library routines to start and stop a
live recording session.

Docker
Back to Top
This release provides support to enable you to run your COBOL and PL/I applications in Docker
containers, taking advantage of the many benefits offered by the Docker platform such as portability,
performance, agility, isolation, and scalability.
Documentation on working with large applications
Back to Top

10
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The product help now includes a new section, Working with a Large Code Base, that includes
recommendations and best practices for working with large applications inside the IDE. It includes tips on
how to structure your projects, how to optimize the performance of the IDEs, and step-by-step workflow
showing how to move an existing legacy application into Visual COBOL.
Enterprise Server
Back to Top
The following enhancements have been made to Enterprise Server:
•

Conversation filtering - the Enterprise Server Communications Process (MFCS) can now restrict access
to listeners by client address. You can specify any permitted or forbidden addresses either by IP
address, network mask, or domain name, and use wildcards. Filters can be applied to individual
listeners, communications processes, or to entire regions. More specific filter rules override any general
ones.

•

The Enterprise Server Security Facility now starts throttling Verify requests when it receives more than
100 requests per second.
This can be used to limit the effectiveness of denial-of-service and brute force attacks. You can
configure the value where throttling occurs. See Verify Request Throttling for more information.

•

(Technology Preview only) Support for adding, deleting, and modifying XA resources in a live Enterprise
Server region.
It is now possible to add, edit, or delete XA resources while an enterprise server instance is running.
Any changes made come into effect after any in-flight transactions have completed. The ability to make
these changes in a live environment comes under the control of the existing enterprise server
permissions.

•

XA-compliant Resources (XARs) - this release provides enhanced CTF tracing that allows more flexible
reporting of warnings and errors on the RM switch module level.

•

A new Communications Server resource class - enables you to control the access to the Enterprise
Server Console Log and Communications Server Log when external security is in effect for an
enterprise server region; see Resource Classes for Communications Server for more information.

•

Improved catalog availability - there is now an improved resilience to temporary communication issues
with the catalog and error reporting enabling a region to stay active if a region has multiple catalogs
defined and one of the catalogs is not available.

•

Enhanced SSL/TLS certificate support - for communications with TLS (formerly SSL), additional
certificate and key file formats are supported. Servers may now be configured with both an RSA and an
ECC key and certificate.
Enhanced SSL/TLS cipher configuration - for communications with TLS (formerly SSL), the permitted
cipher suites and their preferred order can now be configured. The minimum size of Diffie-Hellman
groups for DH key exchange can also be configured. The defaults have been made more secure.

•

•

•

The Historical Statistics Facility (HSF) now enables you to write user-defined data to the records
produced within a .csv file. Use the ES_WRITE_CUSTOM_HSF or ESCSTHSF library routines within
your COBOL programs to define the custom data, and use the ES_HSF_CFG environment variable to
configure up to five custom fields in the generated record.
You can also use the ES_HSF_CFG environment variable to configure the number of CICSF, TSQ, and
TDQ fields that are written to the record.

Enterprise Server for .NET
Back to Top
This release provides the following enhancements:
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•

•

Limited support has been added for TLS (SSL) - you can now configure TN3270 and MFBINP listener
channels for TLS (SSL). The seeout command-line utility and the JES public class API also now support
TLS.
Enterprise Developer for Visual Studio includes a new wizard that enables you to convert native MSS
projects to managed MSS ones. The wizard is invoked using the Create Managed Mainframe Project
context-menu command at project level in Solution Explorer.

File Handler
Back to Top
This release provides the following enhancements:
•
•

The DFSORT and SYNCSORT emulations now support the NULLOFL parameter of the OUTFIL
statement.
The ASCIISOSI configuration option is now available. It adds the required SOSI characters to the
relevant EBCDIC DBCS character strings in order for them to be displayed or written out correctly.

HCO for DB2 LUW
Back to Top
This release includes the following new features:
•
•
•
•

Support for CHARSET EBCDIC COBOL stored procedures
Seamless integration with DB2 LUW SBCS databases, providing various EBCDIC collation sequences
64-bit HCO command-line tools are now available across all supported platforms
HCO DCLGEN enhancements that provide more copybook generation options

IMS support
Back to Top
This release introduces the following new features:
•

•

•

The IMS Database Forward Recovery feature has been updated to provide point-in-time forward
recovery that enables you to recover all database transactions completed up to a specified point in time,
including date and time of day.
IMS support now includes MFS code for Light Pen devices. In your MFS, include a DEV statement with
the FEAT=PEN parameter, and set the ATTR property on appropriate fields to DET or IDET to make
them detectable by a light pen. See your IBM documentation for details.
Note: MFS that contains light pen code must be regenerated to take effect if the MFS is part of an
Visual COBOL project created using an earlier release.
Support for export and import of IMS-configured enterprise server regions through Server Explorer.

JCL support
Back to Top
This release introduces the following new features and enhancements:
•

•

•

12

Micro Focus FTP utility - you can now configure MFFTP to not process trailing blank spaces for a GET
command, by setting the new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and
setting the LOCSTAT value TRAILINGBLANKS=FALSE.
A new API has been introduced - MVSSPLPB - that enables you to search all job information held in the
JES spool control files. It is more comprehensive that the existing MVSCASPB API, and should instead
be used for all new spool enquiries.
A number of new environment variables have been introduced that enable you to configure the JES
startup behavior with regards to opening user catalog files. You can configure JES to open user catalog
files only when they are required (and not during system startup), and you can configure JES to retry
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•

opening a catalog file that has failed to open. These changes increase the resilience of the JES system,
as you can mitigate against JES startup failures if the user catalog files are not readily available whilst
the region starts. See Configuring Multiple Catalogs for more information.
The public catalog API, MVSCATPB, has been enhanced to better report on file errors when opening
catalog files. The following new functions have been added to mfpubcat.cpy: GCFS, GNFS, STNI,
GCFE, and GNFE.

Library routines
Back to Top
The following library routines contain new functionality:
•
•

CBL_GET_OS_INFO - this library routine can now detect if the program is running within a Docker
container: cblte-osi-rts-capabilities parameter, bit 7.
CBL_DEBUG_START and CBL_DEBUG_STOP - these library routines have been enhanced to start
and stop a live recording session.

Mainframe Access
Back to Top
The installation process has been changed as follows:
•
•
•

A single installer for both Mainframe Access and the Mainframe Access z/Server support is provided.
There is now only one XML configuration file for Mainframe Access. There is also a new configuration
utility that guides you through the configuration process.
Specify your own JES console character - it is now possible to configure the Mainframe Access
installation to use a different JES console character instead of the default ("$"). To achieve this, use the
new JES_CONCHAR configuration parameter.

Enhancements are available in the following areas:
Managed COBOL
Back to Top
Deploying JVM COBOL to an Application Server:
•

Running JVM COBOL under WebSphere 9.0 and WebLogic 12.2.1 is now supported.

Micro Focus Unit Test Framework
Back to Top
This release provides support for the following functionality:
•
•

Generation of unit test stubs for selected entry points within your program.
Support has been added to Visual Studio for unit testing of managed procedural projects.

OpenESQL
Back to Top
This release provides the following new features:
•
•
•

Support for SQL Server 2017.
The SQL(TRANSACTION) compiler directive has been enhanced to clearly define transaction
boundaries.
A new SQL(NOWHERECURRENT) compiler directive that allows you to define updateable cursors that
do not do positioned updates or deletes with PostgreSQL or MySQL.

Micro Focus Academic Program 4.0 - Release Notes
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•
•

Larger communication area (PID) that accommodates longer plan and program names.
SQL(OPTIMIZECURSORS) has been enhanced for consistent and better cursor performance across all
OpenESQL backends.

Platform support
Back to Top
Note the following changes in platform support for this release:
•

Windows 8 and Windows Server 2012 are no longer supported for developing applications. They are
still supported for deployment.

PL/I support
Back to Top
Note: PL/I applications that were created using Enterprise Developer 3.0 and earlier must be
recompiled in Enterprise Developer 4.0 to ensure they will compile and execute properly.
Support has been added to Eclipse for the following features in PL/I debugging:
•
•
•
•
•
•
•
•
•

Displaying complex data structures in the Expressions and Variables views.
Viewing the console window on non-Windows platforms so that output and input can be seen or
entered.
The Outline view in the default Debug perspective.
Watchpoints on variables on the line where the variable has been declared.
Conditional breakpoints.
Skipping variables a defined number of times before the execution stops.
Adding expressions to the Expressions view from the Outline view.
Inspecting variables when referenced as part of a macro argument.
Signals and conditions.

PL/I compiler and Run-Time System enhancements:
•
•
•
•
•
•
•
•
•

Support for the following built-in functions - CHARVAL(), COMPARE(), CURRENTSIZE(), EDIT(),
PICSPEC(), SOURCEFILE() and SOURCELINE().
Support for additional DATETIME() format strings.
Support for the FLUSH FILE(*), ITERATE, and RESIGNAL statement.
Support for the XMLOMIT and XMOLATTR attributes on variable declarations.
Support for the MARGINI compiler option.
Support for the SIZE and STRINGSIZE prefix conditions.
Improved support for the repeat factor on arrays of AREA variables.
Improved pointer arithmetic on 64-bit platforms.
Where necessary, MFPLX now recognizes selected *PROCESS statements and passes them to the
appropriate preprocessors.

PL/I EXEC preprocessor:
•

The EXEC preprocessor now honors the -margins setting for the output MDECK in addition to the input
file. This provides an improved experience in the Eclipse IDE when using the Outline view and other
PL/I features provided by the background parser.

PL/I macro preprocessor:
•

The Micro Focus macro preprocessor now provides a new default behavior that mimics IBM's
RESCAN(ASIS) behavior. In addition, a new option, rescan_upper, has been introduced to enable you
to optionally mimic IBM's RESCAN(UPPER) behavior.

Improvements in compatibility with IBM's Macro Preprocessor:

14
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•
•
•
•
•
•

Allows OTHER as an acceptable abbreviation for OTHERWISE on a macro SELECT statement.
Supports the SCAN/NOSCAN option on declaration of macro variables.
Implements the NOSCAN option on ANSWER statements.
The %NOTE message format has been modified to match IBM's behavior.
The SYSVERSION built-in function has been modified to always return a value of 22 bytes in length
(space padded, if necessary).
Relaxed diagnostics for scenarios where Enterprise Developer is generating a warning message and
IBM does not.

(Technical Preview) Generating PL/I test coverage reports in Eclipse:
•

The PL/I Compiler and Run-Time System now support capturing of information showing which lines in
the program have been executed, and the generation of human-readable reports at the conclusion of a
run.

(Technical Preview) Interaction with COBOL AMODE and 370 Assembler programs (Windows 32-bit only):
•

A new compiler option is available which enables Open PL/I to interact with 370 Assembler, and with
COBOL programs compiled with AMODE. See the product help for the current limitations to this
support.

Web service clients
Back to Top
This release provides the following enhancements for Web service clients:
•

Improved support for larger, more-complex WSDL files, including:
•

•

Configurable generation of variable arrays and repeated structures by specifying the Inline-ArraySize-Limit parameter.
• Generation selection for service, port, and one or more operations.
Support for SOAP version 1.2 in addition to version 1.1.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Application Server JCA Support
Application Workflow Modeller
CICS Support
Code Coverage
Codeset Support
Common Communications Interface
Communications Server
Compiler
Data Tools
Documentation
Enterprise Server
Enterprise Server Auditing
Executables require relinking
File Handling
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•
•
•
•
•
•
•
•
•

HCO for Microsoft SQL Server
IDE
Interface Mapping Toolkit
JCL Support
Mainframe Access
MF Server Administrator (GUI)
Micro Focus Directory Server
PL/I Compiler
Run-Time System

Application Server JCA Support for Enterprise Server
•

With this release, all CICS-related Java artifacts have been delivered using a new directory structure
under the javaee-ccl directory of your Visual COBOLCOBOL Server installation directory. The
javaee-ccl directory structure mimics the structure of the javaee directory. For example,
mfccl.jar is no longer located in the bin subdirectory, but can be found in the javaee-ccl
\common directory.

Application Workflow Modeller
Back to the list
•

•

•
•

Source or listing files are now opened in read-only mode when a browse action is executed in the
ChangeMan attachment model.
3138354 (1112546)
A new function package, Micro Focus Background Parser, enables you to define the SYSLIB or
PROCLIB concatenation in which to search for COBOL copybooks, PL/I or JCL include files on the
mainframe or on network drives. The package also enables you to define any identifiers which
determine the structure of the local cache for COBOL copybooks, PL/I or JCL include files.
3132249 (1111922)
The Endevor attachment application now validates the input of a CCID or a comment. They must not be
blank.
Added the new "Modeled Edit Sessions Only" AWM model attribute to control whether modeled editor
actions should be available in non-modeled edit sessions.

CICS Support
Back to the list
•

Starting with version 4.0 Patch Update 2, all applications that use WEB CONVERSE or WEB SEND
SESSTOKEN explicitly with the AUTHENTICATE, BASICAUTH, or NONE options, and that do not use a
URIMAP that specifies the AUTHENTICATE attribute, must be recompiled. (This does not affect
applications that use a URIMAP that specifies the AUTHENTICATE attribute.)

•

Client ECI timeouts now propagate CTG requests to ABEND AITH the ECI server program.

•

The update resource definition file utility, CASRDTUP, now supports the DELETE command. Note that
the REMOVE option is not currently supported.
2885020 (1108004)

Code Coverage
Back to the list
•
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Schema changes that affect the test coverage results generated from the tcutil utility mean that if
you propagate the results to a third-party application (for example, an XSLT processor), and rely on the
<copyFileCoverage> element, you need to alter your transformations to focus on
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<sourceFileCoverage> instead. The element was renamed to more appropriately reflect its
contents, as tcutil now gives global coverage for all source files (not just copybooks).
Codeset Support
Back to the list
•

•

Code-set mappings between ASCII and EBCDIC have been updated when Simplified Chinese is the
language in effect. ASCII table 5210 now maps to EBCDIC CCSID 836 for SBCS conversions. This
replaces the previously conversion (where ASCII table 1042 was used), which would convert the “\”
character to “$”.
3124321 (1111464)
New single-byte character set tables for MFCODESET have been added in order to improve support for
DB2 LUW - both for off-mainframe databases and for access to z/OS DB2. A number of existing
MFCODESET mappings have also been updated. See 'Supported Country Codes' for a full listing of
ASCII/ANSI <-> EBCDIC mappings.
3111843 (1109984)

Common Communications Interface
Back to the list
•

You can now configure the Micro Focus Directory Server and enterprise server region’s listeners to only
use the server's configured SSL and TLS protocols and define a priority ordered cipher suite collection.
This forces connecting clients to use the server’s preferred ordered list of cipher suites when using the
specified protocols.
2866265 (1105526)

•

•

In some circumstances it was possible for a connection to incorrectly accept the identity of an SSL/TLS
peer and allow a connection to complete when the connection should have been denied. This occurred
due to a failure to check the peer's entire identity certificate chain. This has now been fixed. NOTE: You
might need to correct your system’s configured certificate chains that fail verification checks at secure
connection creation time.
In some circumstances it was possible to crash the CCITCP module when it was attempting to obtain
detailed error information about a closed connection. This has been fixed.

Communications Server
Back to the list
•

•
•

TN3270 conversations to Enterprise Server now correctly handle the receive (idle) timeout setting
configured for the listener. There are also two new settings for configuring TN3270 timeouts, "Printers
time out" and "Output resets timeout". See the online product documentation for more information.
3144133 (1113024)
MFCS listeners can now be SSL-enabled without the need to have DemoCA installed.
2868627 (1105777)
MFCS no longer initializes the Security Facility if there are no External Security Managers defined for
the region.

Compiler
Back to the list
•

Programs containing EVALUATE statements of the form: EVALUATE true | false WHEN conditionalexpression where conditional-expression included inline method invokes would give an RTS 114 error
when run as .int code, and an "Illegal .int code" error when generated. This has been fixed. Also, short
circuit evaluation is now correctly observed, such that when evaluating condition-1 AND condition-2, if
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condition-2 contains an inline method invoke and condition-1 is false, then the inline method invoke is
not executed. Previously, despite being correctly evaluated, the inline method invoke in condition-2 was
being executed. Similar behavior relating to OR evaluations has also been corrected.
•

•

•

3138510 (1112492)
During compilation, characters within literals that are unknown in the current locale are now less likely to
cause spurious errors. However, the correct (and safest) solution is to ensure that the locale has been
set correctly, to match the source encoding of these characters. On UNIX, this means setting LANG,
LC_CTYPE, or LC_ALL appropriately; each of these variables takes precedence over the former. On
Windows, this means setting the system locale in the 'Region and Language' section of Control Panel.
3123935 (1111148)
The Compiler now produces an E level message - COBCH1888 Typedef is defined differently in another
external program - if different external programs have conflicting definitions of the same typedef name.
(To restore the previous behavior, where the earlier definition was ignored, use the directive
HIDEMESSAGE"1888".)
An issue with the Compiler has been fixed so that in the RECORD VARYING clause, if the minimum
and maximum lengths are specified, the maximum length must be greater than the minimum length.

Data Tools
Back to the list
•

Records with an invalid value for a conditional field will no longer result in a match for that conditional
layout.
2853226 (1103406)

Documentation
Back to the list
•

•

You can use 'byte' or 'BYTE' as a synonym for the binary-char unsigned data type. As a result, 'byte'
and 'BYTE' are now reserved words in Managed COBOL. Use the REMOVE"BYTE" Compiler directive
to prevent an error being produced for existing programs that use the reserved word as a user-defined
word.
3147576 (1113323)
As of version 3.0, references to types within an assembly other than mscorlib need to be explicitly
referenced. You can achieve this by using the ILREF Compiler directive. (Previously, in certain
circumstances, the Compiler would allow access to types within the System.dll assembly without the
need for an ILREF"System" directive.
3121002 (1111373)

Enterprise Server
Back to the list
•

•

•
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The External Security Facility (ESF) can now be configured to throttle large volumes of incoming Verify
(user authentication / signon) requests to improve resilience to denial-of-service and brute force attacks.
See "Verify Request Throttling" for more information.
3113639 (1110160)
The LDIF files used to create the sample configuration for Enterprise Server LDAP-based security no
longer create an empty "PHYSFILE" resource class. Changes in the JCL engine as of ES 3.0 caused
most jobs to fail when submitted to a security-enabled region using such a configuration. See the
product help for more information.
The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports the
Argon2 hash algorithm for creating password verifiers. See MLDAP ESM Module Custom Configuration
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Information in the product help for more information. NOTE: The Argon2 hash is optional and not
enabled by default.
•

The MQ pages in ESMAC are now controlled by a new security resource, MQL. This enables you to
either restrict or grant users access. 'MQL*' is a new resource that needs to be added under MFESMAC
similar to existing resources such as 'PCT*' or 'XAT*'. The following is a sample export of the LDAP
repository:
******************************
# Sample security definitions for ESMAC MQ Listeners/Writers pages
#######################
###### MQL*
##
#######################
dn: CN=MQL*,CN=MFESMAC,CN=Enterprise Server Resources,CN=Micro
Focus,CN=Program Data,DC=X
changetype: add
cn: MQL*
objectClass: microfocus-MFDS-Resource
microfocus-MFDS-Resource-Class: MFESMAC
microfocus-MFDS-Resource-ACE: allow:SYSADM group:alter
microfocus-MFDS-Resource-ACE: deny:*:execute
microfocus-MFDS-UID: mfuid
#description: Allow full access any ESMAC MQ Listeners/Writers Screen
******************************

•

•

•

3143258 (1112990)
You can now use the ECIResponse.getReturnCode() method to obtain the return code for any errors
from Enterprise Server.
3142092 (1113248)
Communication with the console daemon has been improved. Messages are displayed more quickly
and requests are being processed more efficiently and, as a result, times for initialization and shutdown
might be reduced.
3136867 (1112483)
Administrators can now add, delete or modify XA resources in the Enterprise Server Administration
Web UI while a region is running.
2589624 (1085625)

•

CICS Web services has been updated to include the ES_TRANCLASS_CWI environment variable,
which enables you to prioritize and limit Web requests in a TRANCLASS-enabled region. When the
ES_TRANCLASS_CWI environment variable has been set to either TCPIPSERVICE (default) or
URIMAP, a TRANCLASS-enabled region processes the elected transaction according to its priority and
associated TRANCLASS.
Note: When using CICS® Transaction Server for z/OS®, Version 3 Release 1, and IBM CICS
initiates the ATTACH transaction followed by the ALIAS transaction for a single Web request, this is
intended to enable the application of different limitations and priorities on these transactions.
Enterprise Server does not support this. Instead, a TRANCLASS-enabled region processes the
requests as a single ATTACH transaction, and uses the ALIAS transaction for security checks.

•

3126381 (1111349)
Web access to the Enterprise Server Console Log and Communications Server Log is now restricted
when the enterprise server region is secured using external security. Users will be required to provide a
valid username and password in order to view either log file.
Web access to the logs can be controlled using the standard ACL definitions under the new
Communications Server resource class, with resources Enterprise Server Console Log and
Communications Server Log. If these resources exist, users require 'read' access to be allowed to
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view the logs. If the resources do not exist, the default behavior is to allow 'read' access on entry of a
valid username and password.
An example of the new resource class and resource definitions can be found in the
es_default_ldap_msuser.ldf file, which is located in the bin sub-directory of your product
directory.
Enterprise Server Auditing
Back to the list
•

•

The maxRetryTime value in the audit configuration file now treats 0 as a no timeout time, and any
negative number as an infinite timeout.
3150566 (1113592)
Any extra information that was added to the syslog messages will now correctly appear in the structured
data items.

Executables require relinking or recompiling
•

Due to an internal change in version 4.0 of your product, you must at least relink any executable
programs compiled prior to this version, to make them compatible with the latest run-time system.
However, a full recompilation of your source code is the recommended action, to allow your executables
to benefit from the product's latest programming and performance enhancements.
Relinking an executable without recompiling means using the original object code with the cbllink
utility. Original object code is typically the binary file output (usually containing the .obj extension)
produced during the original compilation process. An application can contain one or more binary files.

File Handling
Back to the list
•

•

In some cases the ESF LDAP Security Administration Web Interface inadvertently removed users from
groups when changing their password. This has been fixed.
3124294 (1111259)
The ESF LDAP Security Administration Web Interface can now filter by Class and Resource name,
description, and ACL. Previously, you could only filter on Class name.
2871549 (1106119)

•

•

For .NET applications, set XFHLOG=DEFAULT to create the XFHLOG file in the current directory;
otherwise it is created in C:\ProgramData\Micro Focus\[ED/VS]\[Release]. From release 4.0 onwards,
this variable also has an effect for native applications.
3115116 (1110323)
Setting the configuration option ASCIISOSI=ON will adds the required SOSI characters to the relevant
EBCDIC DBCS character strings, in order for them to be displayed or written out correctly.

•

3113802 (1110183)
The OPEN mode of SYSOUT files now honors the DISP specified in the JCL.

•

3109432 (1109745)
OPEN I-O of a virgin ESDS file now correctly returns a file status of 35, as it does on the mainframe.
2887724 (1108443)

•

The TO parameter is now supported for TOT|TOTAL, MIN, MAX, and AVG in the TRAILER3 trailer item.

•

3135298 (1112194)
The OUTFIL statement of a SORT operation now supports the NULLOFL parameter.
3110364 (1109822)
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•

The MFJSORT OUTFIL emulation now supports the VLTRIM parameter.
3107105 (1109820)

HCO for Microsoft SQL Server
Back to the list
•

•

The HCOSS Manage Connections tool was incorrectly limited to using the default CCSID for mainframe
DB2 connections, causing problems when mainframe database did not use the default CCSID of 37.
This has been corrected by the addition of a text box that enables the setting of a specific CCSID value
for the connection.
3130137 (1112180)
When using the DIALECT=MAINFRAME setting, the OpenESQL STRICTPARSE SQL compiler
directive option is now turned on by default for ODBC (DBMAN=ODBC). This ensures strict compliance
with z/OS DB2 syntax.
If your applications require the OpenESQL preprocessor to behave as it did in an earlier release,
compile using NOSTRICTPARSE.

IDE
Back to the list
•

New functionality to support the debugging of CICS channels and containers has been added to this
release.
2810448 (1098047)

•

Code blocks in PL/I editor can now be folded. You can configure the PL/I editor to fold various block
types. To do this, click Window > Preferences > Micro Focus > PL/I Editor > Folding, and check the
options that you require.
2867993 (1105654)

Interface Mapping Toolkit
Back to the list
•

•

Refresh Resources functionality has been added to regenerate existing service interfaces for COBOL
programs whose linkage section has been updated after the service interface was initially created.
2849403 (1103036)
Due to changes made to the Configure Runtime Environment dialog box in this release, after you
upgrade your system, you must reenter all previously set values on this dialog box before running a
service.

JCL Support
Back to the list
•

•

•

You can now configure MFFTP to not process trailing blank spaces for a GET command, by setting the
new control variable MFFTP_PROCESS_TRAILS_ONGET=FALSE and setting the LOCSTAT value
TRAILINGBLANKS=FALSE.
3138375 (1112486)
ICEGENER now does not copy the RECFM from SYSUT1 to SYSUT2 if SYSUT2 RECFM is not
specified in JCL and when SYSUT1 is VSAM. It defaults to F/FB if SYSUT2 is non-VSAM, or V/VB if
SYSUT2 is VSAM.
3131268 (1111805)
An error in identifying the IDENT in IEBGENER when the record included high values at the start of the
record has been corrected.
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•

•

•

3109443 (1109759)
FOR ED 2.3.2 HF7: The following changes have been made to the MF_UCC11 environment variable:
MF_UCC11=Y - when running a job with DISP=(NEW,CATLG), it will not result in job failure caused by
the data set already being cataloged. MF_UCC11=YR - when restarting a job with
DISP=(NEW,CATLG), it will not result in job failure caused by the data set already being cataloged. For
ED 3.0 HF1: The following changes have been made to the MF_UCC11 environment variable: The
default behavior of MF_UCC11=Y has changed: DISP=NEW is changed to DISP=MOD only when the
job is restarted. MF_UCC11=YA reverts to the old behavior of changing DISP=NEW to DISP=MOD
even when the job is first run.
3107409 (1109722)
The introduction of a new environment variable, ES_OLD_DYN_PDS, has changed the resulting
behavior of dynamic PDS members when specified in a JCL DD statement. Default behavior
(ES_OLD_DYN_PDS=N) no longer creates physical files or catalogs the PDS members when specified
in a JCL DD statement. Set this variable to Y to enable the previous default behavior of creating the
physical files and cataloging PDS members when specified in a JCL DD statement.
2845176 (1102528)
To prevent unintended deletion of a GDG Bias, a GDG in use by one job may not be accessed by a
second job until the first job has completed.
2816745 (1101569)

Mainframe Access
Back to the list
•

Calling mfmon2.exe with the following options has the given effect:
1. If you do not specify "EXTENSION" or specify "EXTENSION=" it will result in files downloaded
without an extension.
2. If you specify "EXTENSION=*" you will get an extension that matches the last part of the data set
name. For example, if the source data set is a.b.c.d then the file extension will be .d.
3. Everything else results in the extension specified. For example, "EXTENSION=txt" will result in files
downloaded with a .txt extension.

MF Server Administrator (GUI)
Back to the list
•

The total number of active sessions or clients in MFDS is now limited to 2000.

Micro Focus Directory Server
Back to the list
•

The mfds -g options D, O, and S have been added to the product Help.

•

2848627 (1102864)
MFDS now disables and limits the scope of Web listeners on add. It also emits a warning if any
insecure Web listeners are displayed in the validate and listener tables.

PL/I Compiler
Back to the list
•

Previously, storing PL/I named constants in big-endian form was incorrect and impaired some instances
of restricted expression evaluation. In ED 4.0, named constants are stored in native form when the bigendian compiler option is in effect.
3150931 (1113613)
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•

Open PL/I now supports the FLUSH statement.

•

3134294 (1112117)
The %PROCESS statement now includes new compile-time options, -pporder and -options. See the
product help for more information.

•

3107667 (1109861)
Pointer subtraction in 64-bit mode now works as expected.

Run-Time System
Back to the list
•
•

The run-time system now produces a more precise error message if a shared object of the wrong bitism
is loaded.
scan64 is no longer available. This has been superseded by the COBOL Analysis functionality in the
IDE.

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•
•
•
•
•
•

CICS
Commuter licenses
Enterprise Server
Installation
Micro Focus Rumba
OpenSSL

CICS
EXEC CICS VERIFY PASSWORD has a failure scenario that doesn't exist on the mainframe. It is currently
not possible to distinguish this failure from an incorrect password on the command itself via the returned
EIBRESP and EIBRESP2.
Under Enterprise Server, the following options mean that an admin LIST request to ESF is necessary to
acquire the appropriate information:
CHANGETIME
DAYSLEFT
EXPIRYTIME
INVALIDCOUNT
LASTUSETIME
If no users are signed on to CICS, then this admin request will be made as the default CICSUSER which
will be rejected.
The VERIFY PASSWORD command will return NOTAUTH 2, "The supplied password is wrong".
This is misleading because it implies that the value for PASSWORD on the command itself is incorrect.
Note that in that case, CICS returns NOTAUTH 2 as per the mainframe.
The aggregated return code from ESF to CICS for the admin request is identical in both cases and so
CICS has no way of distinguishing between these two failure scenarios. We therefore cannot return a new
EIBRESP or EIBRESP2 for this particular case.
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To allow CICSUSER to make admin LIST requests, the anonymous list option needs to be enable in the
region's security manager configuration (not the Security Manager):
[Admin]
allow-list=yes
Commuter licenses
If there are a number of entries displayed in the License Administration tool, these might be either for
different products or for the same product but for different serial numbers, for example.
When a commute request is made using the license manager, that request is serviced from a pool of
licenses that could be provided by any number of Micro Focus product licenses stored on that server. The
commute request cannot target a particular RMS license by product name, serial number, or number of
cores.
The products to which you apply the commuter licenses will be licensed correctly but the number of
licenses left in the License Administration tool might appear to be less than expected. This issue is more
likely to occur with multiple entries for the same product.
If you are using a number of different products, Micro Focus recommends that you use a different licensing
server for each product in order to help minimize the issue.
Enterprise Server
•

On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Installation
•

Installing this product fails if Micro Focus License Manager version 10000.2.02070 (April 2015) or older
is already installed on your machine. The setup files does not upgrade the License Manager
automatically to the latest version. You must uninstall the existing version before you start the
installation.

Micro Focus Rumba
Rumba 9.5 is not supported on Japanese Windows.
OpenSSL
The version of OpenSSL included in Visual COBOL and Visual COBOL 4.0 is intolerant of expired X.509
certificates in the CA Root Certificate collection in some circumstances. Specifically, if you configure a PEM
file that contains multiple certificates as the collection of trusted CA certificates, and one or more of the
certificates in that file have expired, OpenSSL might not be able to load and use other certificates in the file
which are still valid. This can cause certificate validation errors and connection failures for SSL and TLS
connections.
To work around this, you need to remove any expired certificates from such collections. If necessary,
replaced them with any valid certificates that have the same Distinguished Name and Modulus (key). This
is a known issue with OpenSSL. Micro Focus is investigating for other possible workarounds.

Installation
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System Requirements
Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.
Visual COBOL and Enterprise Developer for Visual Studio
Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.
The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

1.2GB

75MB

Enterprise DeveloperEnterprise
Developer

2.3GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Visual COBOL and Enterprise Developer for Eclipse on Windows
The disk space requirements are:
Product

Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL

3.7GB

75MB

Enterprise Developer

4.5GB

75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.
For a list of the operating systems each individual product in this package supports, check the Product
Availability section on the Micro Focus SupportLine Web site: http://supportline.microfocus.com/
prodavail.aspx.
•

Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.

Software Requirements
Note: This product includes OpenSSL version 1.0.2n.

Windows
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
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Visual COBOL and Enterprise Developer for Visual Studio:
This product requires Microsoft's Visual Studio - either the Visual Studio Integrated Shell or a more
advanced version of Visual Studio.
The following advanced editions of Visual Studio are required:
Professional, Premium, Ultimate or Community Edition
Professional, Enterprise or Community Edition
If there is no Visual Studio installed on your machine, the setup file will install the Visual Studio Integrated
Shell.
Important:
•

A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Visual COBOL for Visual Studio 2013.

•

Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.
Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).
These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.
As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:
•
•
•

•
•

Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.
Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956
Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.
Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

Visual COBOL for Visual Studio 2015 does not support Visual Studio 2015 Shell as the Shell has a
number of restrictions to COBOL development. The Visual Studio 2015 Shell is not included in the
setup for Visual COBOL for Visual Studio 2015 and before you start the installation, ensure that
there is an advanced edition of Visual Studio 2015 installed on your machine.

Note:
•

•
•
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On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the
Microsoft Download Center.
Microsoft Visual Studio Express Edition is not supported.
You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If you
choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.
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Note that some Visual Studio features might not be available with the Shell. This includes WCF or
the Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for
more details.
The following software is also required:
•
•
•

Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.
Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Visual COBOL and Enterprise Developer for Eclipse:
The following requirements apply to both Visual COBOL and Enterprise Developer:
•

•
•

The setup file installs Visual COBOL and the 64-bit Eclipse 4.7.
Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.
Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.
Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
•

•

•

Oracle's Java Platform (64-bit) version 1.8 or later is required to run the Eclipse IDE; however, the
recommended minimum version is Java 1.8.162 (64-bit), which the Windows product installation will
install if it detects an older version. Java 7, 8 (32 or 64-bit versions), and Java 9 (64-bit version only) are
supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can
download Oracle's Java from Oracle's Web site and install it anywhere on your machine.
Note: To skip installing Java 1.8.162 as part of the product installation, run the setup file with the
skipjre=1 command line option.
Visual COBOL requires:
• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.
The setup file also installs .NET Framework v4.6.1 and the Microsoft's Visual C++ 2010 and 2012
Redistributables.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:
•
•
•

•

•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.
If, when you install Visual COBOL for Visual Studio , the machine does not have Microsoft Visual C++
Redistributable Runtime already installed, it is installed as required by Visual COBOL. The installation of
Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital signatures,
into the winsxs directory.
If, when you install Visual COBOL for Visual Studio 2013, the machine does not have Microsoft Visual C
++ 2012 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
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software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
•
•

•

If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
Before installing this product , make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:
1. Stop the service, using either the Windows Service Management Console GUI or from a command
line prompt by typing: net stop mf_ccitcp2 Only one instance of the MFDS or CCITCP2
service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open a Visual COBOL command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
Note: The two versions use different paths for environment and registry values, so the list of
configured Enterprise Servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Downloading the Products
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:
Windows
1. Run the productname.exe file and follow the wizard instructions to complete the installation.
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After Installing
Visual COBOL and Enterprise Developer for Visual Studio
You are now ready to run Visual COBOL or Enterprise Developer. From the Windows taskbar click Start >
All Programs > Micro Focus Product Name > Product Name for Visual Studio. (The Start menu is not
available on Windows 8, Windows 8.1, and Windows Server 2012. You use the Start screen to invoke
programs.)
Refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.
Visual COBOL and Enterprise Developer for Eclipse
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.
Installing X Windows on Windows
Some features of Visual COBOL for Eclipse and Enterprise Developer for Eclipse on Windows require an X
Windows installation, so Micro Focus ViewNowX is provided with the product. To install, run the file
ViewNow_X_Server.exe in your Visual COBOL installation. By default this will be in the
%ProgramFiles(x86)%\Micro Focus\Visual COBOL for Visual Studio 2013\ViewNowX
folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
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Uninstalling
Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.
Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
Some registry entries are not removed by the uninstallation process and you need to manually delete
them.
The following folders might not be removed:
•
•
•
•

Micro Focus Product Name folder in the Start menu - you can delete it manually.
%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.
%ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
%Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer
Copyright © Micro Focus 2018. All rights reserved.
The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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